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AXIS COMMUNICATIONS<Product Name> Quick User’s Guide

About This Document
This manual is intended for administrators and users of the 
AXIS 231D/232D Network Dome Camera, and is applicable 
for Firmware release 4.30. It includes instructions for using 
and managing the AXIS 231D/232D on your network. 
Previous experience of networking will be of use when 
installing and using this product. Some knowledge of UNIX 
or Linux-based systems would also be beneficial, for 
developing shell scripts and applications. Later versions of 
this document will be posted to the Axis Website, as 
required. See also the product’s online help, available via 
the Web-based interface.

Safety Notices Used In This Manual
Caution! - Indicates a potential hazard that can damage the 
product.
Important! - Indicates a hazard that can seriously impair 
operation. 
Do not proceed beyond any of the above notices until you 
have fully understood the implications.

Intellectual Property Rights
Axis AB has intellectual property rights relating to 
technology embodied in the product described in this 
document. In particular, and without limitation, these 
intellectual property rights may include one or more of the 
patents listed at http://www.axis.com/patent.htm and one 
or more additional patents or pending patent applications 
in the US and other countries.
This product includes software developed by the OpenSSL 
Project for use in the OpenSSL Toolkit: 
http://www.openssl.org/

Legal Considerations
Camera surveillance can be prohibited by laws that vary 
from country to country. Check the laws in your local 
region before using this product for surveillance purposes. 
This product includes one (1) MPEG-4 decoder license. To 
purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular 
installation.
If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following 
measures: Re-orient or relocate the receiving antenna. 
Increase the separation between the equipment and 
receiver. Connect the equipment to an outlet on a different 
circuit to the receiver. Consult your dealer or an 
experienced radio/TV technician for help. Shielded (STP) 
network cables must be used with this unit to ensure 
compliance with EMC standards.
USA - This equipment has been tested and found to comply with the 
limits for a Class A digital device, pursuant to Part 15 of the FCC rules. 
These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is 
likely to cause interference, in which case the user will be required to 
correct the interference at his own expense.

Canada - This Class A digital apparatus complies with Canadian 
ICES-003. 

Europe -  This digital equipment fulfills the requirements for 
radiated emission according to limit A of EN55022/1998, and the 
requirements for immunity according to EN55024/1998 residential, 
Download from Www.Somanuals.co
commercial, and industry. Warning! This is a Class A product. In a 
domestic environment this product may cause radio interference, in which 
case the user may be required to take adequate measures.

Japan - This is a class A product based on the standard of the Voluntary 
Control Council for Interference by Information Technology Equipment 
(VCCI). If this equipment is used in a domestic environment, radio 
disturbance may arise. When such trouble occurs, the user may be required 
to take corrective action. 

Australia - This electronic device meets the requirements of the Radio 
communications (Electromagnetic Compatibility) Standard 1998 AS/NZS 
3548.  
Warning! This is a Class A product. In a domestic environment this product 
may cause radio interference, in which case the user may be required to 
take adequate measures.

Liability
Every care has been taken in the preparation of this manual; 
Please inform your local Axis office of any inaccuracies or 
omissions. Axis Communications AB cannot be held responsible 
for any technical or typographical errors and reserves the right 
to make changes to the product and manuals without prior 
notice. Axis Communications AB makes no warranty of any 
kind with regard to the material contained within this 
document, including, but not limited to, the implied warranties 
of merchantability and fitness for a particular purpose. Axis 
Communications AB shall not be liable nor responsible for 
incidental or consequential damages in connection with the 
furnishing, performance or use of this material.

Trademark Acknowledgments
Acrobat, Adobe, Boa, Ethernet, IBM, Internet Explorer, Linux, 
Macintosh, Microsoft, Mozilla, Netscape Navigator, UNIX, 
Windows, WWW are registered trademarks of the respective 
holders. Java and all Java-based trademarks and logos are 
trademarks or registered trademarks of Sun Microsystems, Inc. 
in the United States and other countries. UPnP is a certification 
mark of the UPnPTM Implementers Corporation. Axis 
Communications AB is independent of Sun Microsystems Inc.

Axis Customer Services
Should you require any technical assistance, please contact 
your Axis reseller. If your questions cannot be answered 
immediately, your reseller will forward your queries through 
the appropriate channels to ensure a rapid response. If you are 
connected to the Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. Search by 

product, category, or phrases
• report problems to Axis support staff by logging in to your private 

support area
• visit the Axis Support Web at www.axis.com/techsup/

Safety Notice - Battery Replacement
The AXIS 231D/232D uses a 3.0V CR2032 Lithium battery as 
the power supply for its internal real-time clock (RTC). This 
battery will, under normal conditions, last for a minimum of 5 
years. Low battery power affects the operation of the RTC, 
causing it to reset at every power-up. A log message will appear 
when battery replacement is required.
The battery should not be replaced unless required!
If the battery does need replacing, please observe the following 
points:
Caution!
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as 
   recommended by the manufacturer.
• Dispose of used batteries according to the manufacturer's 
   instructions.

AXIS 231D/232D Network Dome Camera User’s Manual 
Revision 2.1
Date: October 2005 
Part No: 25788
Copyright© Axis Communications AB, 2004-2005
m. All Manuals Search And Download.



 3 AXIS 231D/232D 
Table of contents

AXIS 231D/232D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

AXIS 232D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Hardware Inventory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Hardware Description. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Using the Network Dome Camera . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Accessing the AXIS 231D/232D. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
The Live View page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
The Control panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Video Streams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Stream Types. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
MPEG-4 protocols and communication methods  . . . . . . . . . . . . . . . . . . . . . . . . . . 14
How to stream MPEG-4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
The AXIS Media Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Other methods of accessing the video stream. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Configuring the Network Dome Camera. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Accessing the Setup Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Overview of the Setup Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Video & Image Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
MPEG-4 Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Live View Config . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
HTML Examples. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
External Video. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Sequence Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Dome Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Event Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Event Servers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Event Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Motion Detection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Port Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

System Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Date & Time  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Network - Basic TCP/IP Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Network - Advanced TCP/IP Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
SOCKS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Download from Www.Somanuals.com. All Manuals Search And Download.



 4 AXIS 231D/232D 
SMTP (email) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
SNMP. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
UPnP™ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
RTP (Multicast)/MPEG-4  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Ports & devices - I/O Ports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Advanced. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
About . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Resetting to Factory Default Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Using the Control Button. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

Connection Module  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Checking the Firmware  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Updating the Firmware  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Emergency Recovery Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Symptoms, Possible Causes and Remedial Actions . . . . . . . . . . . . . . . . . . . . . . . . . 49

Technical Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

General performance considerations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Optimizing your system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Frame rates - Motion JPEG . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Frame rates - MPEG-4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Bandwidth. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Download from Www.Somanuals.com. All Manuals Search And Download.



 5 AXIS 231D/232D - AXIS 231D/232D
AXIS 231D/232D
Ideal for demanding surveillance and remote monitoring applications, the AXIS 
231D/232D Network Dome Camera features precise pan/tilt/zoom control, superior quality 
Motion JPEG and MPEG-4 video, advanced event management functionality, 4 alarm 
inputs/4 alarm outputs (i.e. door sensors, alarm bells), 20 preset positions, Sequence Mode 
and Guard Tour. With security features such as HTTPS and IP address filtering, the AXIS 
231D/232D is perfect for professional security installations.

Up to 20 viewers can access the camera simultaneously when using Motion JPEG and 
MPEG-4 unicast. Video can be viewed in 5 resolutions (up to 4CIF), image compression is 
configurable.

The AXIS 231D/232D has a built-in Web server, providing full access to all features 
through the use of a standard Web browser. The built-in scripting tool allows basic 
applications to be created, providing basic surveillance solutions. For advanced 
functionality, the Network Dome Camera can be integrated via the use of AXIS HTTP API. 
For more information, refer to http://www.axis.com/developer

Axis products are supported by the industry's largest base of application software for 
managing and recording video, and integrating alarm and access control systems. 

 

AXIS 232D
The AXIS 232D Network Dome Camera is a day and night camera with an IR cut filter 
which enables the camera to capture color video in light conditions down to 0.3 lux, and 
black and white video in conditions down to 0.005 lux. The IR-cut filter can be 
automatically enabled/disabled according to the current light conditions or manually 
enabled/disabled from the internal web pages.
Download from Www.Somanuals.com. All Manuals Search And Download.
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Hardware Inventory
Check the items supplied with your network dome camera against the following list:

Item Title/variant Notes

Network Dome Camera AXIS 231D/232D

Printed user documentation AXIS 231D/232D Installation 
Guide

Warranty Warranty document

Connection module Connection module Power/alarm connections

Cable 22-pol connection cable 24V AC, 3A power connection 
I/O connections

Power supply Country specific

Hardware Description

Serial number

Connection module
connector

Network connector

S/N
with Network and

 Power Indicators

Control button

Network Connector- After completion of the startup and self test routines, the Network 
and Power Indicators show as follows:

Indicator Color Description

Detail - network connector:

Network
Indicator

Power
Indicator

Network Green Flashes for network activity

Red Slow flash for failed firmware upgrade

None No connection

Power Green Normal operation

Amber Flashes green/amber during upgrade. 

Control Button - Press this button to restore the factory default settings, as described in 
Resetting to Factory Default Settings, on page 43 or for installation as described in the 
provided AXIS 231D/232D Installation Guide and also available from the Axis Web site at 
http://www.axis.com.

The Serial Number (S/N) is located on the label on the unit.
Download from Www.Somanuals.com. All Manuals Search And Download.
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Network Connector - The AXIS 231D/232D connects to the network via a standard RJ45 
connector. The AXIS 231D/232D detects the speed of the local network segment 
(10BaseT/100BaseTX Ethernet).

 

Connection Module - The connection module 
provides the physical interface to 4 transistor 
outputs, 4 digital inputs and is the connection 
point for AC power. See Connection Module, on 
page 45

AC Power

4 outputs
4 inputs

Connection module connector

.

 

 

 

 

 

For instructions on how to install the AXIS 231D/232D, please refer to the AXIS 
231D/232D Installation Guide which is supplied with the product in printed format or in 
PDF format from the Axis Web site at http://www.axis.com.
Download from Www.Somanuals.com. All Manuals Search And Download.
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Using the Network Dome Camera
This document includes instructions for using and managing the AXIS 231D/232D. 
Instructions on how to install the AXIS 231D/232D on your network are provided in the 
AXIS 231D/232D Installation guide which is available on the Axis Web site. The AXIS 
231D/232D can be used with most standard operating systems and supports Microsoft 
Internet Explorer 6.x or later, Netscape 7.x or later and Mozilla 1.4 or later.

Accessing the AXIS 231D/232D

1. Start a Web browser (Internet Explorer, Mozilla, Netscape Navigator).

2. Enter the IP address or host 
name of the AXIS 231D/232D in 
the Location/Address field of 
your Web browser.

3. Enter the user name and password set by the administrator. 

4. A video image is displayed in your Web browser. 

Note: • To view streaming video in Microsoft Internet Explorer, Axis recommends you set your browser to allow the 
AXIS Media Control (AMC) to be installed on your computer. The first time an MPEG-4 video stream is 
accessed AMC also installs an MGPEG-4 decoder for viewing the video streams. As a license is required for 
each instance of the decoder, the product administrator may have disabled the installation. If your work 
environment restricts the use of additional software components, you can configure the AXIS 231D/232D 
to use a Java applet for updating images. Please refer to the online help files for more information.

• User functions in the AXIS 231D/232D may have been customized to meet the specific requirements of the 
application. Consequently, many of the examples and functions in this section may differ from those 
displayed in your Live View page.
Download from Www.Somanuals.com. All Manuals Search And Download.
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The Live View page
If the dome camera has been customized, the buttons and other items described below will 
be displayed accordingly on the Live View page. The following provides an overview of 
each button:

The Video Format drop-down list allows the video format on the Live 
View page to be temporarily changed.

The Output buttons control an output directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout.

Pulse - click this button to activate the port for a defined period of time, e.g. to 
switch on a light for 20 seconds. 
Active/Inactive - click these buttons to manually start and stop a connected 
device, e.g. switch a light on/off.

These buttons start/stop the Sequence Mode. This mode is created in Setup > 
Live View Config > Sequence mode and automatically displays the view from 
preset positions at set intervals.

The Action buttons trigger an action directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout. Click these 
buttons to manually start and stop events.

Use the Snapshot button to capture a snapshot of the image currently being 
displayed in the window. Right-click on the image to save it in JPEG format 
on your computer.

The Live View toolbar displays the following buttons:
The Play/Stop buttons start and stop the live video stream.

The Snapshot button takes a snapshot of the currently displayed image. The 
Snapshot function and the target directory for saving snapshots can be configured 
from AMC (AXIS Media Control), which is available from the Windows Control 
Panel (Internet Explorer only).
Click the View Full Screen button and the video image will fill the entire screen 
area. No other windows will be visible. Press Esc (Escape) on the computer 
keyboard to cancel full screen view.

 

Download from Www.Somanuals.com. All Manuals Search And Download.
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Pan/Tilt/Zoom controls

The controls available for the Pan/Tilt/Zoom (PTZ) are displayed on the Live 
View by default. These are enabled/disabled for specified users by the 
administrator under System Options > Security > Users > User List. 

The Pan Tilt and Zoom bars control their respective functions in two different 
ways. Clicking anywhere on the bar's gradient allows for a 'smooth' 
adjustment of the camera's position, while clicking on the arrows at the two 
ends of the bar cause a stepped, incremental change

• the Pan bar - moves the camera to the right and left
• the Tilt bar - tips the camera up and down
• the Zoom bar - zooms the view in and out
• the Focus bar - adjusts the focus
• the Iris bar - adjusts the brightness of the image

Clicking on the bars themselves or on the arrows at the end of the bars will move the 
camera to a new position.

.

Note: Setting the iris and focus manually will disable Auto iris/Auto focus.

Each position on the bar represents a defined position in the camera’s range of movement, 
with the center of the bar representing the point midway between the two extremes of 
movement.

Clicking a position directly on the bar moves the camera directly to the new position in 
one smooth movement. Clicking on the arrows at the ends of a bar causes a stepped, 
incremental change. 

Click-in-image
The PTZ device can also be controlled using click-in-image movement, which has two 
different types of navigation; Center and Joystick.

Center mode means that when clicking in the image, the camera view will center on the 
absolute position that was clicked.
Download from Www.Somanuals.com. All Manuals Search And Download.
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Joystick mode moves the camera in the direction of the mouse pointer. By clicking and 
holding the mouse button down in the image, the PTZ device moves the camera in that 
direction, relative to the center of the image. The further from the center the image is 
clicked, the greater the movement. The camera stops moving when the button is released.

Focus and Iris Controls
The Focus and Iris (image brightness) can be adjusted manually by using the control bars, 
or they can be set for automatic adjustment, by clicking the Auto Iris and Auto Focus 
buttons.

Preset Positions
These presets are selected from the drop-down Source list on the Live View page and will 
move and/or zoom the camera to a pre-defined position, i.e. to cover an area of particular 
interest. Events can also be configured to go to preset positions when triggered. For 
information on setting up preset positions, please see Dome Configuration, on page 26 and 
the online help.

Using CGI links to control PTZ devices
User-defined CGI links on the Live View page can be used to issue HTTP API requests, e.g. 
PTZ commands. These links are configured in the Live View Layout settings, see page 23.

The Control panel

Click the Ctrl panel button to display the control panel, where the 
following settings are available:

• Auto focus: Automatically adjusts the image focus.
• Auto iris: Automatically adjusts the amount of light 

reaching the camera and gives the best results, This also 
protects the image sensor from strong light.

• Backlight comp: Enabling backlight compensation makes 
the subject clearer if the image background is too bright, 
or if the subject is too dark. 

• Navigation mode: “Center” will move the camera view to 
center on the position that was clicked. 
“Joystick” moves the camera in the direction indicated by 
a mouse click, relative to the center of the image. The fur-
ther from the center the image is clicked, the greater the 
movement.
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• IR cut filter - when set to off, the camera will be able to “see” infrared light, e.g. 
at night, thus making the image clearer. The image is shown in black & white 
when the IR cut filter is off. Set to Auto to automatically turn the  
filter off when the available visible light falls below the minimum requirement.

• Shortcuts - These buttons can be configured to provide direct access to various 
built-in auxiliary commands provided by the PTZ driver. See Advanced - Ctrl 
Panel on page 26.

Pan/Tilt/Zoom Control Queue
This means that the time the user is in control of the PTZ settings is limited and that a 
queue of users has been set up. Use the buttons to request or release control of the 
Pan/Tilt/Zoom controllers. 

The Pan/Tilt/Zoom Control Queue is set up by the administrator under:  
Dome Configuration > Control Queue > PTZ Control Queue.

For more information on using Pan/Tilt/Zoom controls, please see page 10
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Video Streams
The AXIS 231D/232D provides several different image and video stream formats. The type 
to use depends on your requirements and on the properties of your network. 

The Live View page in the AXIS 231D/232D provides access to Motion JPEG and MPEG-4 
video streams, as well as to single JPEG images. Other applications and clients can also 
access these video streams/images directly, without going via the Live View page. 

Stream Types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then 
displayed and updated at a rate sufficient to create a stream that shows constantly updated 
motion. 

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides 
excellent image quality and access to each and every individual image contained in the 
stream.

Note also that multiple clients accessing Motion JPEG streams can use different image 
settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can 
provide high quality video streams at less than 1 Mbit/s. 

Notes: • MPEG-4 is licensed technology. The AXIS 231D/232D includes one viewing client license. Installing 
additional unlicensed copies of the viewing client is prohibited. To purchase additional licenses, con-
tact your Axis reseller.

• All clients viewing the MPEG-4 stream must use the same image settings.

The MPEG-4 standard provides scope for a large range of different coding tools for use by 
various applications in different situations, and the AXIS 231D/232D provides certain 
subsets of these tools. These are represented as Video object types, which are selected for 
use with different viewing clients. The supported video object types are:

• Simple - sets the coding type to H.263, as used by e.g. QuickTime™. 
• Advanced Simple - sets the coding type to MPEG-4 Part 2, as used by AMC (AXIS 

Media Control) 

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the 
amount of bandwidth usage to be controlled. CBR (Constant Bit Rate) is used to achieve a 
specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (Variable 
Bit Rate), the quality of the video stream is kept as constant as possible, at the cost of a 
varying bit rate. 
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MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport 
protocols and broadcast methods are employed.

• RTP (Realtime Transport Protocol) is a protocol that allows programs to manage the 
real-time transmission of multimedia data, via unicast or multicast. 

• RTSP (Real Time Streaming Protocol) serves as a control protocol, to negotiate which 
transport protocol to use for the stream. RTSP is thus used by a viewing client to start a 
unicast session, see below.

• UDP (User Datagram Protocol) is a communications protocol that offers limited service 
for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alterna-
tive to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not 
required to deliver all data and may drop network packets when there is e.g. network 
congestion. This is suitable for live video, as there is no point in re-transmitting old 
information that will not be displayed anyway.

• Unicasting is communication between a single sender and a single receiver over a net-
work. This means that the video stream goes independently to each user, and each user 
gets their own stream. A benefit of unicasting is that if one stream fails, it only affects 
one user.

• Multicast is bandwidth-conserving technology that reduces bandwidth usage by simul-
taneously delivering a single stream of information to multiple network recipients. This 
technology is used primarily on delimited networks (intranets), as each user needs an 
uninterrupted data flow and should not rely on network routers.

How to stream MPEG-4
Deciding on the combination of protocols and methods to use depends on your viewing 
requirements, and on the properties of your network.

RTP+RTSP 
This method (actually RTP over UDP and RTSP over TCP) should be your first 
consideration for live video, especially when it is important to always have an up-to-date 
video stream, even if some images do get dropped. This can be configured as multicast or 
unicast. 

Multicasting provides the most efficient usage of bandwidth, especially when there are 
large numbers of clients viewing simultaneously. Note however, that a multicast broadcast 
cannot pass a network router unless the router is configured to allow this. It is thus not 
possible to multicast over e.g. the Internet. 

Unicasting should be used for video-on-demand broadcasting. However, if more and more 
unicast clients connect simultaneously, the server will at some point become overloaded. 
There is also a maximum of 20 simultaneous viewers to be considered.
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RTP/RTSP
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it 
is relatively simple to configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP or RTP/RTSP/HTTPS
These two methods can also be used to traverse firewalls. Firewalls are commonly 
configured to allow the HTTP protocol, thus allowing RTP to be tunneled.

The AXIS Media Control 
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) from the 
AXIS 231D/232D is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer 
for Windows. This ActiveX component is automatically installed on first use, after which it 
can be configured by opening the AMC Control Panel applet from the Windows Control 
Panel. Alternatively, right-click the video image in Internet Explorer.

Other methods of accessing the video stream
Video/images from the AXIS 231D/232D can also be accessed in the following ways:

• If supported by the client, the AXIS 231D/232D can use Motion JPEG server push to 
display video. This option maintains an open HTTP connection to the browser and sends 
data as and when required, for as long as required. 

• As single JPEG images in a browser. Enter e.g. the path: http://<ip 
address>/axis-cgi/jpg/image.cgi?resolution=CIF

• Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The 
paths that can be used are listed below, in the order of preference.

• Unicast via RTP: axrtpu://<ip address>/mpeg4/media.amp
• Unicast via RTSP: axrtsp://<ip address>/mpeg4/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<ip 

address>/mpeg4/media.amp 
• Unicast via RTSP, tunneled via HTTPS: axrtsphttps://<ip 

address>/mpeg4/media.amp 
• Multicast:  axrtpm://<ip address>/mpeg4/media.amp
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Other MPEG-4 clients
Although it may be possible to use other clients to view the MPEG-4 stream, this is not 
guaranteed by Axis. 

For some other clients, e.g. QuickTime™ the Video Object Type must be set to Simple. It 
may also be necessary to adjust the advanced MPEG-4 settings.

To assess the video stream from e.g. QuickTime™ the following path can be used:

rtsp://<ip address>/mpeg4/1/media.amp 

This path is for all supported methods, and the client will negotiate with the network 
camera to determine exactly which transport protocol to use.
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Configuring the Network Dome Camera
This section describes how to configure the AXIS 231D/232D and is intended for the 
product Administrator who has unrestricted access to all Setup tools and Operator who 
has access to Video & Image, Live View Config and Event Configuration. See the section on 
Security, on page 34 for more information on user access control.

The AXIS 231D/232D is configured under Setup from a standard browser.

Accessing the Setup Tools

Follow the instructions below to access the Setup Tools from a Web browser.

1. Start the Web browser and enter 
the IP address or domain name 
of the AXIS 231D/232D in the 
location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup tools.

Overview of the Setup Tools
Setup tools
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Video & Image Settings
The following descriptions offer examples of the available features in the AXIS 
231D/232D. For details of each setting, please refer to the online help files which are 
available from each page. Click  to access the help files.

Image Settings
To optimize the video images according to your requirements, modify the following 
settings under Image Appearance. Each setting is described in the online help files 

All configuration of images and overlays will affect the performance of the network 
camera, depending on the usage and the available bandwidth.

• High resolution generates larger files
• Lower compression improves image quality, but generates larger files
• Black & White uses less bandwidth than Color
• Rotating the image 90 or 270 degrees will lower the maximum frame rate
See also the specifications for frame rates and bandwidth in General performance 
considerations, on page 54. 
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Overlay Settings
Use these settings to include a) an 
image as an overlay, and/or b) the 
date and time, along with text of 
your own. 

Text overlays are all included on 
one line at the top or bottom of the 
video image. Image overlays can be 
placed anywhere in the video 
image. 

To upload an overlay image, see 
below.

Video Stream
The Maximum video stream time 
can be set as Unlimited, or a 
maximum stream time per session in seconds, minutes or hours can be defined. When the 
set time has expired, a new stream can be started by refreshing the page in the Web 
browser. Note that the maximum video stream time does not apply to clients connecting 
via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can 
also be limited. Select either Unlimited or define a maximum frame rate per viewer.

For a preview of the image and overlay settings before saving, click Test. When you are 
satisfied with the settings, click Save.

Overlay Image Settings
An overlay image is an image included in the Live View. This might, for example, be your 
own company logo. Follow these instructions to upload and use an overlay image:

1. Go to Setup > Video & Image > Overlay Image. 

2. To upload the file (a logo or image) to the AXIS 231D/232D, click the Browse button 
and locate it on your computer or server. 

3. Click the Upload button and follow the on-screen instructions.

4. The image is now available in the Use overlay image drop-down list.

5. Click Save.

6. Go to Setup > Video & Image and modify the parameters under Overlay Settings.

Date &
Time

image
Overlay
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Overlay image requirements:

Image Formats Image Size
The height and width of the overlay image 
in pixels must be exactly divisible by 4.

Overlay image limitations: 

Please use the online help files for more information.

Advanced
Advanced Camera Settings -To optimize the lighting settings according to your 
requirements, modify the following settings under Lighting Conditions:

• White balance - the white balancing system in the AXIS 231D/232D can 
automatically detect white in the image and intelligently use this as a reference 
for other colors.

• Exposure control - this setting is used to adapt to the amount/type of light being 
used. Allow slow shutter can be enabled/disabled when the exposure control is 
set to Automatic.

• IR cut filter (AXIS 232D only)- when the IR cut filter is set to OFF, the camera will 
be able to ‘see’ infrared light, e.g. at night, thus making the image clearer. The 
image is shown in black & white when the IR cut filter is off. 
Note: If set to Auto, the camera will automatically switch between IR cut filter ON 
and OFF, according to the current lighting conditions. This is only possible when 
the iris is set to Auto Iris, and the exposure control is set to Automatic.

• Backlight compensation - this setting is used to make the subject appear clearer. 
against e.g. a bright background.

 

Image Settings

• Auto focus enabled (default setting).
• Sensitivity - sets the speed of the auto focus. High is used when focusing on 

objects that move frequently. Low improves the stability of the focus.

• Windows 24-bit BMP (full color)

• Windows 4-bit BMP (16 colors)

• OS/2 4-bit BMP (16 colors)

• If the image overlay and text overlay are larger than the video image, no overlay will be displayed. When also using a text 
overlay, this will occupy 16 pixels in height and as many in width as the video image. Please consider this when configuring 
the overlay image.

• If the overlay is initially positioned so that part of it is outside the video image, it will be relocated so that it appears over the 
video image, i.e. the entire image is always displayed.

• The maximum overlay image size supported by the AXIS 231D/232D is the same as the maximum image resolution. See Tech-
nical Specifications, on page 46.
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Note: In certain situations, the white balancing system will not operate effectively. Problems may occur if the 
image contains no white color at all, or if the dominant color is not white. In these circumstances, the 
white balance may incorrectly be based on another visible color in the image, and colors may become dis-
torted. A pale background picture with reddish or blue foreground objects is very symptomatic of this con-
dition. In such cases it is recommended that a fixed white balance setting is selected. 

Please use the online help files for more information.

MPEG-4 Settings
Tools for adjusting the MPEG-4 settings and for controlling the video bit rate. 

The MPEG-4 standard provides many different coding tools for various applications in 
different situations. As most MPEG-4 clients do not support all of these tools, it is usual to 
instead define and use subsets for different clients or groups of clients. These settings allow 
you to define the type of viewing client to use.

Adjusting the maximum bit rate and setting it to variable or constant is a good way of 
controlling the bandwidth used by the MPEG-4 video stream.

For more information on these advanced settings, please see the online help files
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Live View Config

Layout
These are the tools for deciding the layout 
of the Live View page. 

The layout can be set in 3 ways:

• Use Axis look - the layout is 
unchanged.

• Use custom settings - modify the 
default page with your own colors, 
images etc. Click the Configure button 
and see the Custom Settings page.

• Own Home Page - Upload and use your 
own custom made page as the default 
web page. Click the Configure button 
and see the following page.

The other settings on this page concern 
which additional features to include, such 
as buttons and links. See page 23 for 
more information.

Customizing the 
default page

The appearance of the 
default AXIS 
231D/232D Live View 
page can be customized 
to suit your own 
requirements, or you 
can upload and use 
your own home page. 
To upload your own 
files, click the 
Upload/Remove button 
under Custom Settings 
and follow the Upload 
Own Web Files 
instructions.

Note that the setup address is http://<ip address>/operator/basic.shtml
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Upload Own Web Files - Your own web files, background picture, color etc. must first be 
uploaded to the AXIS 231D/232D in order to be available for selection in the Custom 
Settings dialog. Once uploaded, the files are shown in the drop-down list.

1. Enter the path to the file, e.g. a file located on your workstation or click the 
Browse button.

2. Select the User level for the uploaded file. Setting the user access level means that 
you have complete control over which pages can be viewed by which users.

3. When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the drop-down lists in the lower section of the page. To 
remove a file, check the box provided next to it and then click the Remove button.

Modify the Axis Look - In this area of the Custom Settings dialog you can use your 
uploaded files, choose colors and include logos and banners. Click the radio button Own: 
and select the file from the drop-down list.

To use an external file located somewhere other than in the AXIS 231D/232D, click the 
radio button External: and enter the URL. 

Own Home Page- To use a previously uploaded web page as the default page, check the 
box Use own home page and select the page from the drop-down list.

User Defined Links 
User defined links can be CGI links or web links. 
Once configured, the link(s) will appear on the 
Live View page.

To set up a web link, select the Use as web link 
radio button, enter a descriptive name and enter 
the URL in the provided field. Click Save and the 
link will appear on the Live View page. 

User defined CGI links can be used to issue HTTP 
API requests, e.g. PTZ commands. 

Example:

1. Check Show Custom Link 1

2. Enter a descriptive name, e.g. CAM START.

3. Select the Use as cgi link radio button and 
enter the cgi link in the field: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=30,-30

4. Check Show Custom Link 2.

5. Enter a descriptive name, e.g. CAM STOP.

User Defined Links
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6. Select the Use as cgi link radio button and enter the cgi link in the field: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=0,0

7. These links will appear in the web interface and can be used to control the dome 
camera.

Please use the online help files for more information.

For more information on the Axis HTTP API, see the Support / Developer pages on the 
Axis Web site at http://www.axis.com. See also the section on PTZ, on page 37.

Action Buttons

These buttons can be used to manually trigger and stop an event from the Live View page. 
See Event Servers, on page 32. The snapshot button allows you to take a snapshot of the 
video stream and save it to a computer.

Output Buttons

These buttons are used to control the outputs on the AXIS 231D/232D and thus the 
equipment connected to them, e.g. to switch a light on or off:

• The Pulse button activates the port for a defined period
• Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format

Select the default format to use on the Live View page. Checking the box for Show video 
format selection displays a drop-down list on the Live View page allowing you to 
temporarily change the format. 

Default Viewer 
When using Microsoft Internet Explorer (IE) in Windows, select your preferred method of 
viewing moving images. The options are: 

• AMC(ActiveX)- This is the best choice for fast image updating in Internet 
Explorer, but might not be possible on computers that have restriction on the 
installation of additional software.

• QuickTime - For use with MPEG-4 only, select this to use the QuickTime plug-in 
for Microsoft Internet Explorer.

• Java applet - This alternative uses a Java applet to update the images in the 
browser.

• Still Image - Displays still images only. Hit the Refresh button in your browser to 
view a new image.
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When using any other browser than Internet Explorer, select the appropriate method from 
the drop-down list for viewing images. The available options are similar to Internet 
Explorer except for Server Push. With this method, the camera maintains and controls an 
open HTTP connection to the browser and sends data as and when required for as long as 
required.

Please see the online help for more information.

HTML Examples
You can add live video from your AXIS 231D/232D to your own web site. The video server 
can send Motion-JPEG or MPEG-4 images to up to 20 simultaneous connections, although 
an administrator can restrict this to fewer. This does not affect or include the number of 
multicast viewers.

By choosing the video format from the drop-down list, a new dialog appears where you 
enter the Image Type, Image size and other settings to suit your web page and click 
Update.

External Video

An external video source is a source originating from another Axis device on the network. 
The images from these sources can be displayed just as if they were produced by the AXIS 
232D.

The External Video Source list shows all of the external video sources currently configured. 
The information displayed is the source's name and the path to the video stream. Up to 20 
external video sources can be configured.

To add a new video source, click the Add button. This opens the External Video Source 
Setup dialog, which is used to make all the necessary settings. 

Sequence Mode

The Live View page can be configured to rotate through the selected preset positions, in a 
set order or randomly.

Select the desired PTZ preset positions and enter the time in seconds to display each 
position (up to 59 minutes). Click Save.

The Sequence buttons will appear on the Live View page to enable the viewer 
to start and stop the sequence mode.
Download from Www.Somanuals.com. All Manuals Search And Download.



 26 AXIS 231D/232D - Dome Configuration
Dome Configuration

Preset Positions 
A preset position is a pre-defined camera view than can be used to quickly move the 
camera to a specific location.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera 
to the required position. When satisfied with the camera's position, enter a descriptive 
name and click on Add. The camera position, iris and focus settings are then saved as a 
preset position. 

The position can be assumed at any time, 
by selecting the preset's name from the 
Preset positions drop-down list. Preset 
positions can be used in a Sequence mode 
(Live View Config>Sequence mode) and 
Event Types (Event Configuration>Event 
Types)

One position can be set as the Home 
position, which is readily accessible by 
clicking on the Home button in both the 
Preset Position Setup window and the Live 
View window. 

Guard Tour
A guard tour moves between chosen Preset Positions, one-by-one, in a pre-determined 
order or randomly, and for configurable time periods. Unlike the Sequence Mode, which is 
a viewing application under Live View Config (see page 25), the guard tour sequence will 
keep running after the user has logged off or closed the Web browser.

Advanced
Limits - Define the pan, tilt, zoom and focus limits for the AXIS 231D/232D. Movements 
to the left and right, up and down can be restricted to narrow the area under surveillance. 
The near focus limit can be set to avoid focusing on objects too close to the camera.

Note: Once a limit has been saved, this position can not be exceeded by the dome camera unless the values have 
been reset and saved to a greater value first (i.e. reset the default values of the mechanical restrictions).

Move speed sets the speed of the camera's Pan/Tilt movements. The default setting is 
maximum speed.
Download from Www.Somanuals.com. All Manuals Search And Download.



 27 AXIS 231D/232D - Dome Configuration
Ctrl Panel - Panel view Settings is a list of configured Shortcut command buttons. Follow 
the online help for instructions to configure buttons to provide direct access to various 
built-in auxiliary commands provided by the PTZ driver and other programmable 
commands. Shortcut buttons are then displayed on the ctrl Panel.

Control Queue
The administrator can set up a queue for the PTZ controllers. Once set up, the PTZ Control 
Queue buttons will appear on the Live View page offering one viewer exclusive control for 
a limited amount of time. Other users will be placed in the queue.

PTZ Control Queue on Live View page

 

Please see the online help for more information.
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Event Configuration
This section describes how to configure the AXIS 231D/232D for alarm handling. The 
AXIS 231D/232D can be configured to perform actions when defined types of events 
occur.

Event type A set of parameters describing how and when the Network Dome Camera is to perform certain actions

the circumstances that start an event e.g. at a signal from an external device, such as a door switch or 
a motion sensor

Scheduled Event page 31 the circumstances that start an event e.g. at a pre-programmed time

Action what occurs when the event triggers e.g. uploaded video images to an FTP server, email notification, 
etc.

Event Servers

Event Servers are used for receiving uploaded image files and/or notification messages. To 
set up Event server connections in your AXIS 231D/232D, go to Setup > Event 
Configuration > Event Servers and enter the required information according to the 
selected server type.

Server type Purpose Requires information

HTTP Server

TCP Server

For details on each setting, please refer to the online help files  which are available 
from each web page.

Note: Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the 
connection test will take approximately 10 seconds). 

Triggered Event page 29

FTP Server • used for uploading saved images • Descriptive name of your choice
• User Name and Password (to FTP server)
• Upload path e.g. images/
• Port number e.g. port 21
• Use passive mode if there is a firewall between 

the dome camera and the FTP server
• Use temporary file if your FTP server doesn’t 

allow an existing file to be overwritten by a 
new file with the same name

• used for uploading saved images
• used for notification messages

• Descriptive name of your choice
• URL
• User Name and Password (to HTTP server)
• Proxy address/Proxy port (if required)
• Proxy User Name and Password (if required)

• used for notification messages • Descriptive name of your choice
• User Name and Password (to TCP server)
• Port number e.g. port 80
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Event Types
An Event Type is a set of parameters 
describing how and when the 
Network Dome Camera is to perform 
certain actions.

Example: If a door is opened, and an event has 
been configured to act on this, the Network 
Dome Camera can e.g. record and save video 
images to an FTP server or send a notification 
email to a pre-configured email address with a 
pre-configured message. Video images can be 
sent as an attachment with the email.

Triggered Event
A Triggered event can be activated from:

• a switch (doorbell) connected to an input port on the Network Dome Camera
• a Pan/Tilt/Zoom Preset position (see page 26)
• Motion detection (see page 32)
• a manually activated action e.g. from an action button in the web interface
• on restart (reboot) after e.g. power loss

How to set up a triggered event
This example describes how to set the Network Dome Camera to upload images when the 
main door is opened:

1. Click Add triggered on the Event types page.

2. Enter a descriptive name for the event, e.g. Main door.

3. Set the priority - High, Normal or Low (see online help files).

4. Set the Respond to Trigger... parameters when the event is to be active, 
e.g. only after office hours

5. Select the trigger alternative from the Triggered by... drop-down list, e.g. an Input 
port with a connected sensor if the door is opened.

6. Set the When Triggered... parameters i.e. set what the Network Dome Camera is to 
do if the main door is opened e.g. upload images to an FTP server or send an email.

7. Click OK to save the Event in the Event Types list.

 

Please use the online help for descriptions of each available option. Image file names 
can be formatted according to specific requirements, such as time/date or type of triggered 
event. See File Naming & Date/Time Formats under Event Configuration.

 

Download from Www.Somanuals.com. All Manuals Search And Download.



 30 AXIS 231D/232D - Event Configuration
 Pre-trigger and Post-trigger buffers
This function is very useful when checking to see what happened immediately before and 
after a trigger, e.g. 2 minutes before and after a door has been opened. 

Go to Event Types > Add Triggered... > 
When Triggered ... and check the Upload 
images checkbox to expand the web page 
with the available options.

Buffer size - up to 9 MB buffer. The 
maximum length of time of the 
pre-/post-buffer depends on the image 
size and selected frame rate.

Include pre-trigger buffer - images 
stored internally in the server from the 
time immediately preceding the trigger. 
Check the box to enable the pre-trigger 
buffer, enter the desired length of time 
and specify the required image frequency.

Include post-trigger buffer - contains images from the time immediately after the trigger. 
Configure as for pre-trigger.

Note: If the pre- or post-buffer is too large for the internal memory, the frame rate will be reduced and individual 
images may be missing. If this occurs, an entry will be created in the unit's log file.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of 
time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, 
or for as long as the trigger is active. Finally, set the desired image frequency to the 
maximum (the maximum available) or to a specified frame rate. The frame rate will be the 
best possible, but might not be as high as specified, especially if uploading via a slow 
connection.
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Scheduled Event
A Scheduled event can be activated at pre-set times, in a repeating pattern on selected 
weekdays.

How to set up a scheduled event
This example describes how to set the Network Dome Camera to send an email notification 
with saved images from at a set time:

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the 
event, e.g. Scheduled email.

3. Set the priority (High, Normal or 
Low).

4. Set the Activation Time parameters 
(24h clock) when the event is to be 
active, e.g. start on Fridays at 18.00 
with a duration of 62 hours.

5. Set the When Activated... parameters 
i.e. set what the Network Dome 
Camera is to do at the specified time 
e.g. send uploaded images to an 
email address.

6. Click OK to save the Event in the Event Types list.

Please use the online help files for descriptions of each available option.
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Motion Detection
Motion detection is used to generate an alarm whenever movement occurs (or stops) in the 
video image. A total of 10 Include and/or Exclude windows can be configured.

• Include windows target specific areas within the whole video image
• Exclude windows define areas within an Include window that should be ignored 

(areas outside Include windows are automatically ignored)
Once configured, the motion detection windows will appear in a list of available triggers, 
for triggering events. See How to set up a triggered event, page 29.

Note: Using the motion detection feature may decrease the camera’s overall performance.

Configuring Motion Detection

1. Click Motion Detection in the Event Configuration menu.

2. Click the Configure Included Windows radio button.

3. Click New.

4. Enter a descriptive name under Windows name.

5. Adjust the size (drag the bottom right-hand corner) and position (click on the text 
at the top and drag to the desired position).

6. Adjust the Object size, History and Sensitivity profile sliders (see table below for 
details). Any detected motion within an active window is then indicated by red 
peaks in the Activity window (the active window has a red frame).

7. Click Save.

If there are parts of the Include window that you wish to exclude, click the 
Configure Excluded Windows radio button and repeat steps 1-8 above.
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Please use the online help for descriptions of each available option.

High Only very large objects 
trigger motion detection

An object that appears in the region will 
trigger the motion detection for a long 
period

Ordinary colored objects against ordinary 
backgrounds will trigger the motion 
detection

Low Even very small objects 
trigger motion detection

An object that appears in the region will 
trigger motion detection for only a very 
short period

Only very bright objects against a dark 
background will trigger motion detection

Default values Low Medium to High Medium to High

Note: 
• Avoid triggering on small objects in the image by selecting a high size level.
• To trigger motion detection as long as there is activity in the area, select a high history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is 

recommended.
• Motion detection is disabled while the PTZ unit is being used.

Port Status

Under Event Configuration > Port Status there is a list that shows the status for the 
connected inputs and outputs of the AXIS 231D/232D for the benefit of the Operator who 
cannot access the System Options section.

Note: If the Normal state for a push button (e.g. doorbell) connected to an input is set to Open circuit - as long 
as the button is not pushed, the state is inactive. If the push button is pushed, the state of the input 
changes to active.

Parameter  Object Size History Sensitivity
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System Options

Security

User access control is enabled by default, the administrator sets the root password on first 
access. Other users are authorized with user names and passwords, or the administrator can 
choose to allow anonymous viewer login to the Live View page, as described below:

Users - the user list displays the authorized users and access levels:

User Description

Viewer Provides the lowest level of access, which only allows the user access to the Live View page.

Operator An Operator can view the Live View page, create and modify event types and adjust certain other 
settings. The Operator does not have access to the Systems Options configuration pages.

Administrator An administrator has unrestricted access to the Setup Tools and can determine the registration of all 
other users. 

User Settings - check the corresponding checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View page.
• Anonymous PTZ control login - allows any viewer access to the Pan/Tilt/Zoom 

controllers on the Live View page.
Maximum number of simultaneous viewers -Limiting the number of viewers accessing 
the server at any one time can be useful if there are limitations on the available bandwidth. 
The maximum of 20 viewers means that subsequent viewers will not see the video stream, 
but instead a blank image.

IP Address Filtering 

Enable IP Address Filtering- To allow or deny access to the AXIS 231D/232D Network 
Dome Camera check the box Enable IP address filtering. Once enabled, the IP addresses in 
the list will be allowed or denied access according to the choice made in the drop-down list 
Allow/Deny the following IP addresses.

The administrator can add up to 256 IP addresses to the list (a single entry can contain 
multiple IP addresses). The users from these IP addresses need to be specified in the user 
list with the appropriate access rights (User, Operator or Administrator).

Referrals - to prevent unauthorized sources from including the video stream from the 
AXIS 231D/232D into external Web pages, check the Referrals checkbox and enter the IP 
address or Host name of the computer that hosts the Web pages with the included video 
stream. Several IP addresses/host names can be defined and are separated by semicolons(;)
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Notes: • If the referrers feature is enabled and you wish to also allow normal access to the Live View page, the 
product's own IP address or host name must be added to the list of allowed referrers.

• Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, IP address 
filtering must be enabled.

• Restricting referrers is of greatest value when not using IP address filtering. If IP address filtering is used, 
then the allowed referrers are automatically restricted to those allowed IP addresses.

HTTPS
For greater security, the AXIS 231D/232D can be configured to use HTTPS (Hypertext 
Transfer Protocol over SSL (Secure Socket Layer)). That is, all communication that would 
otherwise go via HTTP will instead go via an encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the AXIS 231D/232D, a Certificate 
must be created using one of the following methods:

• A self-signed certificate can be created in the network camera, but this does not guar-
antee the same level of security as an official certificate.

• An official certificate issued by a CA (Certificate Authority). A CA issues and manages 
security credentials and public keys for message encryption.

1. Click either Create self-signed certificate or Create Certificate Request and enter 
the required information in the provided fields.

2. Click OK.

3. Create self-signed certificate generates and installs a certificate which will be 
displayed under Installed Certificate. 
Create Certificate Request generates a PEM formatted request which you copy and 
send to a CA for signing. When the signed certificate is returned, click Install signed 
certificate... to install the certificate in the AXIS 231D/232D.

4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to 
enable HTTPS connection (set to HTTP by default)

Please refer to the home page of your preferred CA for information on where to send the 
request etc. For more information, please refer to the online help files

Date & Time

Current Server Time - displays the current date and time (24h clock). The time can be 
displayed in 12h clock format in the Overlay Images (see Date & Time Format Used in 
Images).

New Server Time - Select your time zone from the drop-down list and check the daylight 
saving time changes, if desired. 
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From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your computer. 
• Synchronize with NTP Server - the network camera will obtain the time from an NTP 

server every 60 minutes. Specify the NTP server's IP address or host name.

Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. 
See Network > Advanced TCP/IP Settings below.

• Set manually - this option allows you to manually set the time and date.

Date & Time Format Used in Images - specify the formats for the date and time (12h or 
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See Advanced 
File Naming & Date/Time Formats in the help files for information on how to create 
your own file formats.
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Network - Basic TCP/IP Settings
IP Address Configuration- the IP address of the Network Dome Camera can be set 
automatically via DHCP, or a fixed IP address can be set manually. DHCP is enabled by 
default. To use a fixed IP address, you must also enter the correct subnet mask and default 
router.

Notes: • DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via DHCP 
may lead to the situation where the IP address changes and you lose contact. Configure the options for 
notification of IP address change (under Services) to receive notification from the network camera when 
the IP address changes.

• Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 231D/232D by host 
name which is always the same, regardless of the IP address.

For more information, please refer to the online help files

 

Services

Options for notification of IP address change - if the IP Address for the Network Dome 
Camera is changed e.g. automatically by DHCP, you can choose to be notified of the 
change. Click Settings... and enter the required information.

AXIS Internet Dynamic DNS Service - If the AXIS 231D/232D Network Dome Camera 
has been registered with the Axis Internet Dynamic DNS service and the IP address for the 
product changes, the service is updated to reflect the change. Check the box to 
enable/disable automatic updates. 
 
The domain name currently registered at the Axis Internet Dynamic DNS service for your 
product can at any time be removed. To do this click Settings... and follow the instructions. 

For more information, please refer to the online help files
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Network - Advanced TCP/IP Settings

DNS Configuration

DNS (Domain Name Service) provides the translation of host names to IP addresses on 
your network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided 
by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the 
following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 
231D/232D. Multiple domains can be separated by semicolons (;). The host name is always 
the first part of a Fully Qualified Domain Name, e.g. myserver is the host name in the 
Fully Qualified Domain Name myserver.mycompany.com where mycompany.com is the 
Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

NTP Configuration

Configuring the NTP server can be done automatically or manually. By checking the radio 
button Obtain NTP server address via DHCP the AXIS 231D/232D automatically looks up 
and uses the NTP server as provided by DHCP. 

To specify the server manually, check the radio button Use the following NTP server 
address. Enter the server’s IP address or host name. Note that a DNS server must be 
specified if using a host name.

Host Name Configuration

The AXIS 231D/232D can be accessed using a host name, instead of an IP address. The 
host name is usually the same as the assigned DNS Name. It is always the first part of a 
Fully Qualified Domain Name and is always one word, with no period. For example, 
myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com.

The enable dynamic DNS updates allows you to alias a dynamic IP address to a static host 
name, allowing your computer to be more easily accessed from various locations on the 
Internet. Outside users can always access your server using the associated DNS name 
regardless of the WAN IP. The DNS server used by the user and/or the DNS server 
responsible for the domain in use must support RFC2136 and allow updates from the dome 
camera.

The TTL (Time To Live) value determines how long (in seconds) the reply from the DNS 
server should be remembered when checking that the domain name for the registered IP 
address is still valid. For more information, please see the online help
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Link-Local Address
This is enabled by default and assigns the AXIS 231D/232D an additional IP address for 
use with UPnP™. The AXIS 231D/232D can have both a Link-Local IP and a 
static/DHCP-supplied IP address at the same time - these will not affect each other. 

HTTP 
The default HTTP port number (80) can be changed to any port within the range 
1024-65535. This is useful for e.g. simple port mapping.

HTTPS 
If applicable, enter the HTTPS port the AXIS 231D/232D will use. The default setting (443) 
can be changed to any port within the range 1024-65535. HTTPS is used to provide 
encrypted web browsing.

NAT traversal
Use NAT traversal when your AXIS 231D/232D is located on an intranet (LAN) and you 
wish to make it available from a NAT router. When properly configured all HTTP traffic to 
an external port in the NAT router will be forwarded to the network camera.

Enable/Disable - When enabled, the AXIS 232D will attempt to configure port mapping in 
a NAT router on your network, using UPnP™.

Use manually selected NAT router - Select this option to manually select a NAT router. 
Enter the IP address for the router in the field provided.

If a router is not manually specified, the AXIS 231D/232D will automatically search for 
NAT routers on your network. If more than one router is found, the default router will be 
selected.

Alternative HTTP port - Select this option to manually define an external HTTP port. Enter 
the port number in the field provided. If no port is entered here a port number will 
automatically be selected when NAT traversal is enabled.

For more information, please see the online help

RTSP

The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP 
port number to use. The default setting is (554).

Network Traffic 

The default setting is Auto-negotiate which means that the correct speed is automatically 
selected. If necessary, you can set the connection speed by selecting it from the drop-down 
list.
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Maximum bandwidth - Specify, in Mbit/s or kbit/s, the maximum bandwidth that the 
network camera is allowed to use on your network. This is a useful function when 
connecting your network camera to busy or heavily loaded networks. The default setting is 
Unlimited.

Note: When using MPEG-4 as the video format, remember that setting a maximum bandwidth value here may 
create problems for individual video streams if the maximum value is less than the sum of the bit rates set 
for the video streams. 

For more information, please see the online help

SOCKS 

SOCKS is a networking proxy protocol. The AXIS 231D/232D can be configured to use a 
SOCKS server to reach networks on the other side of a firewall/proxy server. This 
functionality is useful if the Network Dome Camera is located on a local network behind a 
firewall, but notifications, uploads, alarms, etc., need to be sent to a destination outside the 
local network (e.g. to the Internet).

SMTP (email)

(Simple Mail Transfer Protocol) Enter the host names or addresses for your primary and 
secondary mail servers in the fields provided to enable event and error email messages 
from the Network Dome Camera to predefined addresses, via SMTP.

SNMP
The Simple Network Management Protocol (SNMP) allows remote management of network 
devices. Depending on the level of security required, select the version of SNMP to use. The 
three levels of security are:

• SNMP V1 - includes no security.
• SNMP V2c - uses very simple security. The community name can be specified as a pass-

word for read or read/write access to all supported SNMP objects. The community is the 
the group of network devices using SNMP.

• SNMP V3 - provides encryption and secure passwords. HTTPS must be enabled.
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UPnP™

(Universal Plug and Play) The Network Dome Camera includes support for UPnP™ in 
Windows ME and Windows XP. UPnP™ is enabled by default.

Note: UPnP must be installed on your workstation. To do this, open the Control Panel from the Start Menu and 
select Add/Remove Programs. Select Add/Remove Windows Components and open the Networking Ser-
vices section. Click Details and then select UPnP as the service to add. Refer to the Windows help files for 
more information.

RTP (Multicast)/MPEG-4
These settings are the IP address, port number, and Time-To-Live value to use for the video 
stream(s) in multicast MPEG-4 format. Only certain IP addresses and port numbers should 
be used for multicast streams. For more information, please see the online help.

Ports & devices - I/O Ports

The pinout, interface support and the control and monitoring functions are described in the 
section on the Connection Module, on page 45.

Maintenance

• Restart - The unit is restarted without changing any of the settings. Use this method if 
the unit is not behaving as expected.

• Restore - The unit is restarted and most current settings are reset to factory default val-
ues. The settings that will not be reset are as follows:

• the boot protocol (DHCP or static)
• the static IP address
• the default router
• the subnet mask
• the system time

• Default - The default button should be used with caution. Pressing this will return all of 
the network camera's settings to the factory default values (including the IP address).

Dome Status - Click the Test button to check the camera and dome mechanics for errors. 
Contact Axis Customer Services if you receive an error message as the result of this test.

Upgrade Server - See Upgrading the Firmware, on page 55.

Backup - To take a backup of all of the parameters, and any user-defined scripts, click this 
button. If necessary, it is then possible to return to a previous configuration if settings are 
changed and there is unexpected behavior.
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Restore - click the Browse button to locate the saved backup file (see above) and then click 
the Restore button. The settings will be restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not 
intended for multi-configurations or for firmware upgrades.

Support
The Support Overview page provides valuable information on troubleshooting and 
contact information, should you require technical assistance.

System Overview - is a quick look over the camera’s status and settings.  Information that 
can be found here includes the camera’s Firmware version, IP address, Security, Event and 
Image settings and Recent log items.  Many of the captions are also links to the proper 
Setup page to conveniently make adjustments in the camera’s settings. 

Logs & Reports - when contacting Axis support, please be sure to provide a valid Server 
Report with your query.

View Information - The Log report and the Parameter List also provide valuable 
information for troubleshooting and when contacting Axis’ support service.

Configuration:
Log Level for Log Files - from the drop-down list, select the level of information to be 
added to the Log file

Log Level for Email - from the drop-down list, select the level of information to send as 
email and enter the destination email address.
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Advanced
Scripting is an advanced function that provides the possibility to customize and use 
scripts. This function is a very powerful tool. 

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the 
unit. If a script does cause problems, reset the unit to its factory default settings. A 
backup file may be of use to return the unit to its latest configuration). 
 
Axis strongly recommends that you do not use this function unless you fully 
understand the consequences. Note that Axis support does not provide assistance for 
problems with customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis network 
camera configuration. All parameters can be set and modified from this page. Help is 
available from the standard help pages.

About

Third Party Software Licenses - click View licenses for a list of the licensed software 
used in the AXIS 231D/232D Network Dome Camera.

 

Resetting to Factory Default Settings

To reset the AXIS 231D/232D to the original default settings, go to the System Options > 
Maintenance web page (described in Maintenance, on page 41) or use the control button 
on the AXIS 231D/232D as described below:

Using the Control Button

Follow the instructions below to reset the AXIS 231D/232D to factory default settings 
using the Control Button.
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1. Switch off the AXIS 231D/232D by 
disconnecting the power.

2. Press and hold the Control button 
while you reconnect the power.

3. Keep the Control button pressed 
until the Power Indicator flashes 
amber (this may take up to 15 
seconds).

4. Release the Control button.

5. When the Power Indicator changes 
to green (may take up to 1 minute), the process is complete and the AXIS 231D/232D 
has been reset.

Control button

Network Indicator

Power Indicator
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Connection Module
This section describes the pinout provided by the Connection module consisting of: 

24V AC Power

used

4 transistor outputs

(see table below)
4 digital inputs

not 

 

• 4 transistor outputs
• 4 digital inputs
• power and GND (ground)

 

 

The inputs/outputs are used in applications for, e.g. event triggering, time lapse recording, 
alarm notification via email, picture storage to FTP locations.

• Input - e.g. a doorbell. If the doorbell is pressed, the state changes, and the input 
will be active (shown under Event Configuration > Port Status). 

• Output - e.g. an alarm device that can be activated from Output buttons from the 
Live View page or as an action to an Event Type. The output will show as active 
(under Event Configuration > Port Status if the alarm device is activated.

Connection Module Pinout

1. Loosen the corresponding screw on top of the pin (see the table above to determine 
which pin to use).

2. Push the cable into the connector and secure it by fastening the screw.

Function Description Function Description

n/a not used GND ground

n/a not used GND ground

n/a not used Transistor Output 4 See below

n/a not used Digital Input 4 See below

n/a not used Transistor Output 3 See below

n/a not used Digital Input 3 See below

n/a not used Transistor Output 2 See below

PS GND ground Transistor Output 1 See below

24 VAC 24 VAC Digital Input 2 See below

24 VAC 24 VAC Digital Input 1 See below

Digital Input (1-4)- connect to GND to activate or leave floating (unconnected) to deactivate

Transistor Output (1-4)- Max. load 100mA, max. voltage 24V DC. An open-collector NPN transistor with 
the emitter connected to pin 2 (GND). If used with an external relay, a diode must be connected in parallel 
with the load for protection against any voltage transients.
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GND

IN 1

IN 2

IN 3

IN 4
OUT 1

OUT 2

OUT 3

OUT 4

24VAC

GND

24VAC Power~

~
supply

PS GND o

Schematic Diagram - AXIS 231D/232D I/O connectors and power

Note: Unmarked I/O connectors on the connection module can not be used.
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Troubleshooting

Checking the Firmware

One of your first actions when troubleshooting a problem should be to check the currently 
installed firmware version. The latest version may contain a correction that fixes your 
particular problem. See the support section at http://www.axis.com/techsup for 
information on the latest available firmware version. The current software version in your 
AXIS 231D/232D is available from the product Web pages under Setup > Basic 
Configuration.

Updating the Firmware

The firmware is software that determines the functionality of the AXIS 231D/232D. When 
you upgrade to the latest available firmware from the Axis Web site, your Axis product 
will receive the latest available functionality. Always read the upgrade instructions and 
release notes available with each new release, before upgrading the firmware.

New firmware can be uploaded to the AXIS 231D/232D over the network.

Note: Preconfigured and customized settings will be retained for use when the new firmware is running (provid-
ing that the features are available in the new firmware) although this is not guaranteed by Axis Communi-
cations.

1. Save the firmware file to your computer. The latest version of the AXIS 231D/232D 
firmware is available free of charge from the Axis Web site at 
http://www.axis.com/techsup or from your local distributor.

2. Go to Setup > System Options > Maintenance in the AXIS 231D/232D Web pages.

3. In the Upgrade Server section and browse to the desired firmware file on your 
computer. Click Upgrade.

Notes: After starting the process, you should always wait at least 20 minutes before restarting the AXIS 
231D/232D, even if you suspect the procedure has failed.

Your dealer reserves the right to charge for any repair attributable to faulty updating by the user.
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Emergency Recovery Procedure
If power or the network connection to the AXIS 231D/232D is lost during the upgrade, the 
process will fail and the unit will become unresponsive. A flashing red Network LED 
indicates a failed upgrade. To recover the unit, follow the steps below. The serial number is 
found on the label on the product casing.

1. Unix/Linux - From the command line, type the following: 
arp -s <IP address of AXIS 231D/232D> <Serial number> temp 
ping -s 408 <IP address of AXIS 231D/232D> 
 
Windows - From a command/DOS prompt, type the following: 
arp -s <IP address of AXIS 231D/232D> <Serial number> 
ping -l 408 -t <IP address of AXIS 231D/232D>

Note: the ping -l command is the lower-case letter (L) 

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press 
CTRL+C to stop Ping.

3. Open a browser and type in the AXIS 231D/232D’s IP address. In the page that appears, 
use the Browse button to select the upgrade file to use, e.g. axis231d.bin or 
axis232d.bin. Then click the Load button to restart the upgrade process. 

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and 
show a steady green on the Power LED and flashing green or amber on the Network 
LED. 

5. Reinstall the AXIS 231D/232D. 

If the emergency recovery procedure does not get the AXIS 231D/232D up and running 
again, please contact Axis support at www.axis.com/techsup/ 

Support

If you contact Axis Customer Services, please help us help you resolve your problems 
expediently by providing a server report, log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report 
contains important information about the server and its software, as well as a list of the 
current parameters.

Log file - go to Setup > System Options > Logs & Reports. The Log file records events 
within the unit since the last restart of the system and can prove a useful diagnostic tool 
for troubleshooting.
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Symptoms, Possible Causes and Remedial Actions  
Problems setting the IP address

Using ARP Ping The IP address must be set within two minutes after the power has been applied to the AXIS 
231D/232D, restart the server and try again. Also, make sure the ping length is set to 408. See 
the ARP ping description in the installation section.

The AXIS 231D/232D is located 
on a different subnet.

If the IP address intended for the AXIS 231D/232D and the IP address of your computer are 
located on different subnets, you will not be able to set the IP address. Contact your network 
administrator for an IP address on the same subnet as the computer you are performing the 
installation from.

The IP address is being used by 
another device

Disconnect the power from the AXIS 231D/232D.  
Run the Ping command (in a Command/DOS window, type ping and the IP address of the unit). 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that the IP 
address may already be in use by another device on your network. You must obtain a new IP 
address and reinstall the unit. 

If you receive: Request timed out - this means that the IP address is available for use with your 
AXIS 231D/232D. In this case, check all cabling and reinstall the unit.

The AXIS 231D/232D cannot be accessed from a Web browser
Cannot log in. If the AXIS 231D/232D has been configured to use HTTPS, check that the protocol in the URL 

used to access the unit is correct. You may need to type this in manually (i.e. http or https) in 
the browser’s address field.

The IP address has been changed 
by DHCP

1) Move the AXIS 231D/232D to an isolated network or to one with no DHCP or BOOTP server. 
Set the IP address again, using AXIS IP Utility or the ARP Ping command. 
2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the 
main network. The unit now has a fixed IP address that will not change. 
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the 
required service and then configure IP address change notification from the network settings. 
Return the unit to the main network. The unit will now have a dynamic IP address, but will 
notify you if the address changes.

Other networking problems Test the network cable by connecting it to another network device, then Ping that device from 
your workstation. See instructions above.

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network
Firewall protection The AXIS 231D/232D can be configured to use a SOCKS server to reach networks on the other 

side of a firewall/proxy server. See  SOCKS, on page 40 for more information.

Your AXIS 231D/232D is accessible locally, but not externally
Firewall protection Check the Internet firewall with your system administrator.

Default routers required Check if you need to configure the default router settings.

The Internet site is too heavily 
loaded

Use a script running on your web server to relay images from the AXIS 231D/232D to the Inter-
net. 

The Power indicator is not constantly lit
Faulty power supply Verify that you are using the correct power supply.

The Network Indicator is slowly flashing red
A firmware upgrade has been 
interrupted or the firmware has 
in some other way been dam-
aged.

A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP 
and Ping,

Then, from a Web browser, access the unit and upgrade the latest firmware to the product, see 
Updating the Firmware, on page 47.

No images are displayed in the Web interface
Problem with AMC  
(Internet Explorer only)

To enable the updating of images in Microsoft Internet Explorer, set your Web browser to allow 
ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on 
your workstation. 
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For additional assistance, please contact your reseller or check the product’s support pages 
on the Axis Website at http://www.axis.com/techsup

Installation of additional ActiveX 
component restricted or prohib-
ited

Configure yourAXIS 231D/232D to use a Java applet for updating the images under 
Live View Config > Layout > Default Viewer for Internet Explorer. See help files for more infor-
mation.

Video Image Problems
Image too dark or too light. See the help files on Video & Image Settings

Problems uploading own files There is only limited space available for the upload of your own files. Try deleting one or more 
existing files, to free up space.

Missing images in uploads This can occur when trying to use a larger image buffer than is actually available. Try lowering 
the frame rate or the upload period.

Slow image update Configuring, e.g. pre-buffers, hi-res images, high frame rate etc will reduce the performance of 
the AXIS 231D/232D. 

Slow performance Slow performance may be caused by e.g. heavy network traffic, many users with access to unit, 
low performing client, use of features such as Event handling., Image rotation.

Bad snapshot images
Display incorrectly configured on 
your workstation

In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit.

Using only 16 or 256 colors on your display will produce dithering artifacts in the image. 

Problems with the MPEG-4 format
Lower frame rate than expected. Check with the administrator that there is enough bandwidth available. Check also the settings 

for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. Using an inappro-
priate video object type can also affect the frame rate. See the online help for more informa-
tion.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode 
only I frames.

Lower the image resolution.

Reduce the number of applications running on the client computer.

No MPEG-4 displayed in the  
client.

Check that the correct network interface is selected in the AMC control panel applet (network 
tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel 
applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4 
decoder. 

No multicast MPEG-4 displayed 
in the client.

Check with your network administrator that the multicast addresses used by the  
AXIS 231D/232D are valid for your network.

Check with your network administrator to see if there is a firewall preventing viewing.

Multicast MPEG-4 only accessi-
ble by local clients. 

Check if your router supports multicasting, or if the router settings between the client and the 
server need to be configured. The TTL (Time To Live) value may need to be increased.

Poor rendering of MPEG-4 
images. 

Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

Unexpected PTZ behavior
Problem with hardware Go to System Options > Maintenance > Dome Status and click Test to test the camera and 

dome mechanics for errors. Contact Axis Customer Services if you receive an error message as 
the result of this test.
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Technical Specifications

Item Specification

Models • AXIS 231D 50Hz/PAL
• AXIS 231D 60Hz/NTSC
• AXIS 232D 50Hz/PAL (Automatic Day/Night functionality)
• AXIS 232D 60Hz/NTSC (Automatic Day/Night functionality)

Image Sensor • 1/4” Sony EXview HAD CCD

Lens • Autofocus with 18x optical zoom f=4.1mm wide to 73.8mm tele. F1.4-3.0
• Focus range: 0.2m - ∞  (wide), 0.8m - ∞  (tele)

Angle of view • 48o (wide end) to 2.8o (tele end)

Zoom • 18x optical and 12x digital, total 216x

Minimum illumination • Color:0.3 lux at 30IRE
• B/W: 0.005lux at 30IRE (Only AXIS 232D)

Shutter time • 1sec to 1/10.000sec 

Pan range • 360o endless

Tilt range • 0 o- 90o

Max speed • Pan 360o/s

• Tilt 360o/s

Video compression • Motion JPEG
• MPEG-4 Part 2(ISO/IEC 14496-2), Profiles: ASP and SP

Resolutions • 4CIF, 2CIF Expanded, 2CIF, CIF, QCIF
• Maximum 768x575 (PAL) 704x480 (NTSC)
• Minimum 176x144 (PAL) 160x120 (NTSC)

Frame rates
(NTSC/PAL)

• Motion JPEG: Up to 30/25 fps in 4CIF
• MPEG-4: Up to 30/25 fps in 2CIF

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and total bandwidth
• Constant and variable bit rate (MPEG-4)

Image settings • Compression levels: 11 (Motion JPEG), 23 (MPEG-4)
• Configurable brightness, sharpness, white balance, exposure control, backlight 

compensation.
• Overlay capabilities: time, date, text, custom logo or image
• De-interlacing (4CIF resolution)

PTZ Control • 20 preset positions
• Guard tour
• Control queue

Security • Multiple user levels with password protection
• IP address filtering
• HTTPS encryption

Alarm and event 
management

• Events triggered by built-in motion detection, external inputs or scheduled
• Image uploads via FTP, email and HTTP
• Notification over TCP, email, HTTP and external outputs
• Pre- and post-alarm buffer of 9 MB (approx. 4 min CIF video at 4 fps)
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Connectors • Ethernet 10BaseT/100BaseTX, RJ-45
• 4 alarm inputs, 4 outputs

Processors and memory • CPU: ETRAX-100 LX 32-bit
• Video processing and compression: ARTPEC-2 
• RAM: 32MB 
• Flash memory - 8 MB
• Battery backed up real-time clock

Power • 24V AC or DC, max 25W

Operating conditions • 5 - 50oC (41 -122o F)
• Humidity: 20-80% RH (non-condensing)

Installation, management 
and maintenance

• Installation tool on CD and web-based configuration
• support for configuration backup and restore
• Support for firmware upgrades over HTTP or FTP, firmware available at 

www.axis.com

Video access from Web 
browser

• Camera live view
• Sequence tour capability for up to 20 Axis cameras
• Customizable HTML pages
• Complete remote control of pan, tilt and zoom

Minimum web browsing 
requirements

• Pentium III CPU 500 MHz or higher or equivalent AMD
• 128 MB RAM
• AGP graphic card, DirectDraw, 32 MB RAM
• Windows: XP, 2000, NT 4.0*, ME* or 98*
• DirectX 9.0 or later
• Internet Explorer 6.x or later
• For other operating systems and browsers, see www.axis.com/techsup

*Motion JPEG only

System integration 
support

• Powerful API for software integration available at www.axis.com
• Event trigger data in video stream
• AXIS Media Control SDK
• Embedded scripting support 
• Embedded operating system: Linux 2.4

Supported protocols HTTP, HTTPS, SSL/TLS*, TCP, SNMPv1/2cv/v3(MIB-II) RTSP, RTP, UDP, IGMP, RTCP, 
SMTP, FTP, DHCP, UPnP, ARP, DNS, DynDNS, SOCKS. More information on protocol 
usage available at www.axis.com

*This product includes software developed by the Open SSL Project for use in the Open SSL 
Tool kit. See www.openssl.org

Applications
(not included)

• AXIS Camera Station - Surveillance application for viewing, recording and 
archiving up to 25 cameras

• AXIS Camera Recorder Surveillance application for viewing and recording up to 16 
cameras

• AXIS Camera Explorer- Basic software for viewing and manual recording

See www.axis.com/partner/adp_partners.htm for more software application via partners

Item Specification
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Included Accessories • Power supply 24V AC
• Hard ceiling mounting bracket
• Drop ceiling mounting bracket
• CD with installation tool, Software,User manual,MPEG-4 licenses (1 encoder, 1 

decoder) and MPEG-4 decoder (Windows)
• Transparent bubble
• Quick installation guide
• Connection module for power and alarm in/out

Accessories
(not included)

• Videotek DBH24K Dome Housing IP65 rated
• Various mounting brackets for outdoor housing
• Smoked bubble
• Outdoor IP66 rated power supply AXIS PS24
• IR Illumination (Only AXIS 232D)

Approvals - EMC • EMC:CE:EN55022:1994+A1+A2 Class A
• EN61000-3-2:2000
• EN61000-3-3:1995+A1 
• EN55024:1998+A1
• EN61000-6-1:2001
• EN61000-6-2:2001

• FCC part 15 Subpart B Class A
• VCCI: Class A;C-Tick AS/NZS 3548
• ICES-003
• Safety: UL and CSA(power supply), 

EN60950(power supply)

Weight • 1.93kg (4.3lbs) excluding power supply

Item Specification
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General performance considerations

When setting up your system, it is important to consider how various settings and 
situations will affect performance. Some factors affect the amount of bandwidth (the bit 
rate) required, others can affect the frame rate, and some will affect both. If the load on the 
CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. 
Bandwidth affected. 

• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

• Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame 
rate and bandwidth affected.

• Heavy usage of event settings affects the CPU load. Frame rate affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected.
• Viewing on poorly performing client PC’s lowers perceived performance. Frame 

rate affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 
231D/232D provides a tool that can be used to display these values directly in the video 
image.

To do this, special format strings are added as part 
of a text overlay. Simply add #r (average frame 
rate in fps) and/or #b (average bandwidth in Kbps) 
bandwidth in Kbps) to the overlay. 

For detailed instructions, please see the online help 
for Video & Image > Overlay Settings, and the 
help for File Naming & Date/Time Formats. 

Important!
• The figures displayed here are the values as delivered by the server. If other restrictions are  

currently in force, (e.g. bandwidth limitation) these values might not correspond to those  
actually received by the client.

• For Motion JPEG, these values will only be accurate as long as no frame rate limit has been specified.
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Frame rates - Motion JPEG 

The following test results show the frame rates in frames/second (fps) for Motion JPEG 
streams from the AXIS 231D/232D, using a compression level of 50%. Note that these 
values are guidelines only - actual values may vary.

Frame rates - MPEG-4

The following test results show the frame rates in frames/second (fps) for MPEG-4 streams 
from the AXIS 231D/232D. Note that these values are guidelines only - actual values may 
vary.

The MPEG-4 test conditions:

• Compression level = 50%
• Video Object Type = Advanced Simple
• GOV structure = IP*

*Note that setting the GOV structure to use “I-frames only” will increase the frame rate. 

Bandwidth

As there are many factors affecting bandwidth, it is very difficult to predict the required 
amounts. The settings that affect bandwidth are:

• the image resolution
• the image compression
• the frame rate
• the MPEG-4 object type
• the MPEG-4 GOV structure

fps (PAL) fps (NTSC)
4CIF 25 30

2CIF expanded 25 30
2CIF 25 30
CIF 25 30

QCIF 25 30

fps (PAL) fps (NTSC)
4CIF 17 21

2CIF expanded 17 21
2CIF 25 30
CIF 25 30

QCIF 25 30
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There are also factors in the monitored scene that will affect the bandwidth. These are: 

• the amount of motion
• the image’s complexity
• the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important 
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit 
rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the 
network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be 
much lower.
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